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	Creating Tables, Charts, 
and Diagrams


Overview

Chapter 4 covers three very important illustration categories: tables, charts, and diagrams. Students learn add attractive effects to the tables they create, create charts appropriate for various situations, and draw customized diagrams to communicate processes and relationships. 
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Pre Text/ Post Test—Chapter 4
Fill-in-the-Blanks

1. Tables are useful for organizing _____ data.

2. Before inserting a table on a slide, first consider how many _____ your table will require.

3. To select the contents of the cell in the previous column, press the _____ keystroke sequence.

4. The act of undoing a merge of two or more cells is known as _____.

5. Character and _____ formatting commands help make your tables more attractive and easier to read.

6. The_________ shows colors to identify each data series represented in the graph.

7. The Microsoft ___________ application helps you produce great looking charts and graphs.

8. To show data and data relationships in a report you can embed a ________ into a presentation.
9. A ______ is used to hold the values that are used to plot a graph in PowerPoint.

10. An __________ chart is used to show a
hierarchy of formal relationships.

Multiple Choice

11. The intersection of a column and row in a table is known as what?

A. Tools row-column space

B. cell
C. rectangular area
D. none of the above

12. You can insert a table in a PowerPoint slide by pressing which button on the Standard toolbar?
A. Insert Table

B. Insert Grid

C. Add Table

D. none of the above

13. To select a row of cells, you can do which of the following?
A. drag the mouse over the cells

B. click in the desired row, then click the Tables button on the Tables and Borders toolbar and choose the Select Row menu item

C. press the Tab key

D. only a and b

14. To move the insertion pointer to the next cell to the right (in a table), you can press which key?
A. Tab

B. Ctrl

C. Right Arrow

D. A and C
15. When formatting tables, you can choose to format:
A. an entire table

B. a selection of rows or columns

C. a selection of cells

D. all of the above

16. Which of the following can be used to insert a chart into a presentation?
A. click the Insert Chart button on  the Standard toolbar
B. click the Insert Chart button in a content placeholder
C. none of the above
D. all of the above
17. A Microsoft Graph datasheet is similar in nature to a:
A. spreadsheet
B. word processor
C. database
D. web browsers
18. Which of the following is the type of chart which is a schematic drawing showing a hierarchy of formal relationships?
A. pyramid
B. target
C. organizational
D. none of the above
19. Which menu item will display the dialog window that allows you to select and insert a diagram in your presentation?
A. [image: image1.png]



B. [image: image2.png]



C. [image: image3.png]



D. none of the above
20. You can insert which of the following types of diagrams into your presentation?

A. cycle

B. radial

C. pyramid

D. target

E. all of the above
True / False
21. ___Table rows can easily be added in PowerPoint as you edit a table, without changing the structure of the table.
22. ___The Insert Table dialog window does not permit the designation of the number of rows and columns to create in an inserted table.
23. ___To select the contents of an entire table, click the mouse in the table, then click the Table button on the Tables and Borders toolbar, and choose the Select Table menu item.
24. ___You cannot merge cells via the Tables and Borders toolbar.
25. ___When inserting a column or row in a table, the inserted column or row takes on the default formatting for a column or row.
26. ___You can change bar chart colors through the format, selected walls dialog box.
27. ___PowerPoint’s Diagram Gallery allows you to select a diagram format for insertion into your presentation.
28. ___It is not possible to click a button in a content placeholder to insert an organizational chart.
29. ___To connect an assistant to an organizational chart, you must click on the subordinate box.
30. ___You cannot create a custom diagram in PowerPoint. 
Teaching Tips and Lecture Notes
Tables are useful for comparing information in a grid format. For presentation slides, tables must be written very concisely so text can be large enough for easy reading. Alignment and shading techniques can make the information easier to read. 
The most common charts are covered in this chapter. They are each described with suggestions for why each different chart would be used. Chart elements are defined and formatting applied to charts to make them more attractive and easier to interpret.

The final section of this lesson covers diagrams. PowerPoint provides six different diagram formats in its Diagram Gallery, but a diagram of any type can be created using drawing tools. An organization chart and three different diagrams are used to introduce these concepts.
Section 4.1 Creating Tables

Section 4.1 covers the use of tables in PowerPoint slides. Specifically, this section provides instruction on the inserting of a table into a slide, navigation of the insertion point through a table’s cells, and the formatting of table cells and the table itself.

Section 4.1.1 Creating the Table Structure

Concept:
Inserting a table using the Insert Table button

Method:
A table can be inserting into a presentation slide by using the Insert Table button on the Standard toolbar. To insert the table, click in the slide where the table will appear, and then click on the Insert Table button and hold it down. Next, drag the mouse over the grid pattern to choose the number of rows and columns the table will contain. Finally release the mouse button and the table will be inserted.

Notes:
Think in advance about how you want to construct the table. You can always modify a table once it is created and rows are easy to add. But it will take more editing to add columns.
Concept:
Inserting a table using a preset slide layout

Method:
A table can also be inserted into a slide via a preset slide layout (which includes a table). To insert a table using this method, choose the Slide Layout menu item from the Format menu. Then, click a slide layout which includes an Insert Table button. Click the button and provide the number of rows and columns in the dialog window that appears. Finally click the OK button and the table will be placed in the current slide.

Notes:
None.

Section 4.1.2 Navigating a Table and Entering Data

Concept:
Navigating a table

Method:
To move the insertion point around a table, use the following keystrokes:

· Press the Tab key to move to the cell on the right. If the insertion point is positioned in the last cell in a row, the insertion point is moved to the first cell in the next row. If you are positioned in the last cell of a table, pressing Tab will insert a new row.
· Press the Ctrl+Tab keys to move the insertion point to the next tab stop in the cell.
· Use the arrow keys to move from cell to cell within a table, in the direction of the arrow.

Notes:
None.

Concept: 
Entering data
Method:
Press Tab to move between the cells as you enter data. Each table cell can be formatted with its own unique text attributes and paragraph formatting. 

Notes:
None.
Section 4.1.3 Formatting Table Cells

Concept:
Applying text and paragraph formatting

Method:
You can apply text and paragraph formatting within a cell just as you would to ordinary text. Generally speaking, you can select the desired text and use the Formatting toolbar to apply the desired formatting characteristics.

Notes:
When you use column headings, keep their appearance more distinctive than the table contents. You could apply bold or a contrasting color for row shading that blends with your presentation color scheme.
Concept:
Using the Tables and Borders toolbar for table formatting

Method:
The cells of a table (and the table itself) can be formatted by using the Table and Borders toolbar. The toolbar supports such formatting characteristics as setting the background color for a cell, row/column insertion and deletion, cell splitting and merging, as well as border formatting.

Notes:
None.

Concept:
Changing the height or width of rows and columns

Method:
The height and width of rows and columns within a table can be modified by dragging the row and column borders. To do so, position the mouse over a row or column border. When you do this, the mouse pointer will change to two parallel vertical lines surrounded by left-pointing and right-pointing arrows. Drag the border in the desired direction to adjust the cell. Release the mouse to complete the operation.

Notes:
Table row size cannot be smaller than the font size being used.
Section 4.1.4 Sizing and Moving a Table

Concept: 
Sizing a table and then moving it
Method:
Drag sizing handles to vertically or horizontally resize a table. Drag the table border to reposition it on the slide.
Notes:
If you have a series of tables, try to keep their design and sizing consistent.
Section 4.2 Creating Charts for Numeric Information

Four of the most common chart types are covered in this section (column, bar, line, and pie) with design criteria for each one. Chart elements are defined and the importance of maintaining visual integrity is emphasized so that the charts students create will accurately reflect the data they represent. 
The terms charts and graphs are often used interchangeably. However, since Microsoft Graph is the name of the program within Office 2003 that creates these charts, we will adhere to Microsoft’s terminology to call all of these objects charts.
Section 4.2.1 Creating Column Charts

Concept: 
Creating column charts (also called vertical bar charts)
Method:
Click Insert Chart button on the Standard toolbar and Microsoft Graph will load with a Datasheet with sample numbers that is connected to a sample graph. Edit the numbers on the Datasheet to reflect the numbers you need to show.
Notes:
The column chart is the default chart type, so each time you create a chart you will start with this format. Show grid lines if interpretation is enhanced. Show data values if precise numbering is needed. Numbers will be placed above the bars.

Point out the chart elements as you begin working on a column chart: data, data labels, legend, x-axis, y-axis, tick marks, gridlines, chart area, plot area, and 3-D effects.

Be careful when working with the datasheet and when you remove all the contents of a column. The column heading must also be blanked or an empty space will appear on the plot chart area.
Section 4.2.2 Applying Chart Types
Concept: 
Applying different chart types once a chart is created
Method:
With the chart selected, click the Chart Type button on the Standard toolbar (available only when Microsoft Graph is loaded). Additional options are available from the menu if you choose Chart, Chart Type (14 different types with 2-7 variations of each).
Notes:
Try displaying the data by column or by row to see which arrangement best displays what you are trying to compare.
Section 4.2.3 Creating Bar and Line Charts

Concept: 
Creating bar charts
Method:
The same method is used to create all charts.
Notes:
Bar charts display bars horizontally. Show grid lines if interpretation is enhanced. Show data values if precise numbering is needed. Numbers will be placed at the end of the bars. If you wish, numbers can be entered manually in text boxes and positioned on each of the bars.
Concept: 
Creating line charts
Method:
The same method is used to create all charts.
Notes:
Line charts usually need some adjustments to be easy to interpret. By default the lines should be thicker and data markers should be larger. Add callout boxes to highlight key values. 
Section 4.2.4 Creating Pie Charts

Concept: 
Creating pie charts
Method:
The same method is used to create all charts. 
Notes:
By default, a border line appears around the plot area of a pie chart. This line should be removed. A legend identifies what the slice colors represent, but this information is easier to interpret if the labels and values are shown beside each pie slice. Make these adjustments using Chart Options. If you want to emphasize one slice of the pie, then select just that one slice and pull it away slightly from the rest of the pie to “explode” it.
Section 4.2.5 Formatting Chart Elements
Concept: 
Formatting chart elements for easier interpretation
Method:
A variety of techniques are used in this lesson and some were mentioned in the previous section—remove or reposition legends, display gridlines, display numbers, modify lines and data markers, add callout boxes to key information, and apply colors to blend with a presentation color scheme. 
Notes:
While it is important for a chart to be attractive, simple charts are often the best to use because they are easy to interpret. Animation of chart elements is discussed in Chapter 5.
Section 4.3 Creating Diagrams for Processes and Relationships
This section begins with PowerPoint’s Diagram Gallery that has six diagrams—organization chart, cycle, radial, pyramid, Venn, and target diagrams. The instructions cover how to accessing this feature and then modify the diagram’s format once the content is entered. Then creating customized diagrams is discussed.
Section 4.3.1 Accessing the Diagram Gallery
Concept:
Using the Diagram Gallery to insert a diagram 

Method:
To display the Diagram Gallery, click on the Insert Diagram or Organizational Chart button on the Drawing toolbar (or choose the Diagram menu item from the Insert menu).
In the Diagram Gallery dialog window that appears, select one of the six different types of charts to insert and click the OK button. A blank diagram of the style selected is inserted in the slide being displayed.

Notes:
None.

Concept:
Inserting an organizational chart into a presentation

Method:
Use one of the following methods to insert an organizational chart into your presentation:

· Click the Insert Diagram or Organizational Chart icon from the Drawing toolbar or from a content placeholder. Next, click the Organizational Chart icon (top row, left most icon) and press the OK button.

· From the Insert menu, choose Picture, then Organizational Chart.
· Once the organization chart structure is created, use the mouse to click a node on the chart to modify the text in each node. Select the chart object and click the AutoFormat button on the Organization Chart toolbar to modify its appearance. 
Notes:
Using the Organizational Chart toolbar that appears, you can add additional nodes to the chart, rearrange the chart’s appearance, and perform other chart-editing activities.

Section 4.3.2 Creating Custom Diagrams with Drawing Tools
Concept:
Drawing diagrams for specific communication needs 

Method:
Use drawing tools such as AutoShapes to create rectangles and arrows or lines to connect them to create diagrams customized for your specific communication needs. 
When you illustrate in this way, keep the diagram as simple as possible with text labels that are easy to read. 
Notes:
Diagrams created in this way are good illustrations to animate as explained in Chapter 5.
Pre Test/Post Test Answers

	
	Fill in the Blanks
	Multiple Choice
	True/False

	
	1. tabular (4.1:PP 156)
2. columns (4.1.1:PP 157)
3. Shift+Tab (4.1.1:PP 159)
4. splitting (4.1.2:PP 159)
5. paragraph (4.1.3:PP 161)
6. legend (4.2:PP 166)
7. Graph (4.2:PP 165)
8. legend (4.2:PP 165)
9. datasheet (4.2.1:PP 169)
10. organizational (4.3:PP 183)

	11. B (4.1:PP 156)

12. A (4.1.1:PP 157)

13. D (4.1.1:PP 159)

14. D (4.1.2:PP 159)

15. D (4.1.3:PP 161)

16. D (4.2.1:PP 167)

17. A (4.2.1:PP 169)

18. C (4.3:PP 183)

19. B (4.3.1:PP 183)

20. E (4.3.1:PP 184)
	21. T (4.1.1:PP 157)

22. F (4.1.1:PP 158)

23. T (4.1.1:PP 159)

24. F (4.1.2:PP 159)

25. F (4.1.3:PP 161)

26. T (4.2.5:PP 176)

27. T (4.3.1:PP 183)

28. F (4.3.1:PP 184)

29. F (4.3.1:PP 185)

30. F (4.3.2:PP 186)




Self Check Question Answers
1. The easiest way to change the width of a table column is to drag the column and row borders. If precise dimensions are needed, the table margins can be specified in inches using the Format table dialog box.

2. After a table has been created, you can insert a column by clicking the Tables menu on the Tables and Borders toolbar then, from the menu select either Insert Columns to the Left or Insert Columns to the Right. This addition can cause a table to expand off the edge of a slide and, therefore, the table will need to be resized.
3. To increase the readability of table content, remove lines that can give the table a cluttered appearance and, instead, apply row shading. Be careful that the row shading blends with your overall presentation color scheme and also provides good color contrast between the text colors and the colors used for shading.

4. The purpose of the Microsoft Graph program is to visually display numeric information in charts that help people understand the relationships within the data.

5. Maintaining visual integrity means that data proportions are accurately and truthfully displayed in a chart. No distortions are present, so colors and special effects have been carefully applied with accuracy in mind. Text is used to label chart elements for easy interpretation and clarity.

6. For pie charts, data labels are easier to interpret than legends because the words and numbers appear adjacent to the shape that represents the numbers so their connection is instantly obvious. Legends serve to identify what the colors represent, but interpretation is not apparent as quickly.

7. A line chart is most appropriate for displaying changes in quantities over time. 

8. If possible, columns and bars should be arranged from low to high or high to low to aid in interpretation of quantities. However, if the data represented is time based, then the columns or bars must be shown sequentially. 

9. Use the Diagram and Organization Chart button on the Drawing toolbar to insert an organization chart on a slide.

10. A four-part sequential process diagram might look like this:


	True/False 
	Multiple Choice

	1. T

2. T

3. T

4. T

5. T

6. T

7. F

8. T

9. F

10. T
	1. B

2. A

3. D

4. C

5. A

6. A

7. C

8. D

9. C

10. D



Additional Exercises

Activity 1 
Assume you had been asked to recommend computer upgrades for your department at work. Look on the Internet at the site of several computer retailers and examine the features listed for different units. Select the features that would be most important for this situation and arrange the information in a descriptive table that would fit on one slide. Answers will vary, but here is one example.
	Features
	Performance

	Processor
	Intel Pentium 4 Processor at 3Ghz

	Operating System
	Microsoft Windows XP

	Hard Drive
	80GB

	Monitor
	17" UltraSharp Flat Panel

	Productivity Software
	Microsoft Office 2003 Professional


Activity 2

Assume you work for a relocation company. A couple you are working with will soon be retiring and they are interested moving to a sunny, warm location. Prepare a chart showing the average high temperatures in the two locations of Las Vegas and Miami. Decide which chart type will best show this data. Check for comparable data for your hometown at weather.com and include a third data set for comparison. 
Average Highs by Degree
	
	Jan
	Feb
	Mar
	Apr
	May
	June
	July
	Aug
	Sep
	Oct
	Nov
	Dec

	Las Vegas
	60
	66
	73
	82
	91
	102
	108
	105
	98
	85
	69
	60

	Miami
	73
	73
	75
	79
	82
	86
	87
	87
	86
	83
	78
	75


Source: weather.com
Activity 3

Use drawing tools to create a family tree. Sketch your structure first to plan how various family members will be positioned. Use rectangles or a different AutoShape to enter each individual’s name. Once all family members are positioned and the illustration is balanced on the slide, then add connecting lines or arrows to show the connections between each family member.
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